I. Welcome to CorelDRAW

CorelDRAW is a vector-based drawing program that makes it easy to create professional artwork from simple logos to intricate technical illustrations. The enhanced text-handling capabilities and writing tools of CorelDRAW allow you to create text-intensive projects such as brochures and reports with greater ease than ever before.

If you're new to the world of CorelDRAW, you'll soon discover how the new interactive tools and the program's continuous feedback enable you to get up to speed in no time. If you've used CorelDRAW before, you'll soon find out how the new tools and enhanced features give you even more power to design and publish all your graphics.

CorelDRAW Graphics Suite X5 is an intuitive graphic design application that gives designers an enjoyable work experience. Whether you work in advertising, printing, publishing, sign making, engraving or manufacturing, CorelDRAW X5 offers the tools you need to create accurate and creative vector illustrations and professional-looking page layouts.

Exploring the Work Area
When you create a new drawing in CorelDRAW, the large white portion of the screen is the Drawing Window. The rectangle in the center with the drop shadow represents the Drawing Page. Usually, only the part of your drawing that falls within the Drawing Page is printed.

You can think of the remaining space in the Drawing Window as your workspace in which you can keep your tools and pieces of your illustration handy.

The application commands available through the Menu Bars can also be accessed through toolbars and flyouts. The Property Bars and Docker window allow you quick access to frequently used functions. Property Bars, is accessible as you work on your document, enable you to access commands that are relevant to the active tool or the task you're currently performing. The Docker window is a new feature in CorelDRAW that can be docked to the side of the application window.

1. Title bar - displays the title of the open document.
2. Toolbox - a floating bar with tools for creating, filling, and modifying objects in the drawing.
3. Drawing window - The area outside the drawing page bordered by the scroll bars and application controls.
4. Drawing page - The rectangular area inside the drawing window. It is the printable area of your work area.
5. Rulers - Used to determine the size and position of objects in a drawing.
6. Standard toolbar - A detachable bar that contains shortcuts to menu and other commands, such as opening, saving and printing.
7. Property bar - A detachable bar with commands that relate to the active tool or object.
8. Docker - A window containing available commands and settings relevant to a specific tool or task.
10. Color palette - A dockable bar that contains color swatches.
12. Navigator - A button at the lower-right corner that opens a smaller display to help you move around a drawing.
13. Document navigator - The area at the bottom left of the application window that contains controls for moving between pages and adding pages.
14. Status bar - Contains information about object properties such as type, size, color, fill and resolution. The status bar also shows the current mouse position.

II. CorelDRAW X5 Toolbox

1. The Pick tool lets you select and size, skew and rotate objects
2. The Shape edit flyout lets you access the Shape, Smudge brush, Roughen brush and Free transform tools.
3. The Crop tool flyout lets you access the Crop, Knife, Eraser and Virtual segment delete tools.
4. The Zoom/Hand flyout lets you access the Zoom and Hand tools.
5. The Freehand flyout lets you access the Freehand, 2-Point line, Bezier, Artistic media, Pen, B-spline, Polyline and the 3-Point curve.
6. The Smart tools flyout lets you access the Smart fill and Smart drawing tools.
7. The Rectangle flyout lets you access the Rectangle and 3-Point Rectangle tools.
8. The Ellipse flyout lets you access the Ellipse and 3-Point Ellipse tools.
9. The Object flyout lets you access the Polygon, Start, Complex Star, Graph paper, and Spiral tools.
10. The Basic Shapes flyout lets you access the Basic shapes, Arrow shapes, Flowchart shapes, Banner shapes and Callout shapes tools.
11. The Text tool lets you type words directly on the screen as artistic or paragraph text.
12. The Table tool lets you draw and edit tables.
13. The Dimension tool lets you draw Parallel, Vertical, Horizontal Angular, Segment and 3-Point callouts.
15. The Interactive tools flyout lets you access the Interactive blend, Interactive Contour, Interactive distortion, Interactive drop shadow, Interactive envelope, Interactive extrude, and Interactive transparency tools.
16. The Eyedropper flyout lets you access the Color eyedropper and the Attributes eyedropper tools.
17. The Fill flyout lets you access the Fill color, Fountain fill, Pattern fill, Texture fill and PostScript fill dialog boxes, indicate no fill and the Color Docker.
18. The Interactive Fill flyout lets you access Interactive fill and Interactive mesh fill tools.
Using Toolbars

Each button on a toolbar represents a command. Some are shortcuts to menu commands; others are commands that are available only as toolbar buttons.

To Display or Hide Toolbars

1. Click Window, highlight Toolbars.
2. Enable the check boxes beside the toolbars you wish to display; disable the check boxes beside the toolbars you wish to close.

To Dock Toolbars

Drag the Title Bar of the toolbar that you want to dock toward the menus at the top of the application window or to any of the other sides to place it there.

To Size Floating Toolbars

1. Place your cursor over one of the toolbar's edges and wait until it becomes a two-sided arrow.
2. Drag until the toolbar is the shape you want.

Note

You can only change the shape of floating toolbars. When you dock a toolbar, it becomes horizontal when placed on the top or bottom side of the application window or vertical when placed on the left or right side.

Accessing Flyouts

Flyouts are toolbars that are accessible through one tool. A small black arrow at the bottom right corner of a tool indicates that it is a flyout grouped with other tools. You can drag a flyout off its host toolbar by dragging any part outside the button area. This step doesn't actually remove the flyout from the toolbar, but displays it as a separate toolbar.

To Display a Flyout

Click the arrow, or click and hold the mouse button down on the tool.
Using Property Bars

The Property Bar is a context-sensitive command bar that displays different buttons and options depending on the selected tool or object. For example, when text is selected, the Property Bar contains only text-related commands.

If you click the Pick tool to select the object at this point, the Property Bar updates with commands that are relevant for the object. In this case, both transformation commands and formatting commands become available.

If you click a different tool at this point, the Property Bar changes again to display commands and controls for that tool.

To Display or Hide the Property Bar

1. Click Window, highlight Toolbars.
2. Enable the Property Bar check box to display; disable the Property Bar check box to hide.

To Dock the Property Bar

Drag the Title Bar of the Property Bar toward the menus at the top of the Application Window or to any of the other sides to place it there.

Note

When you dock the Property Bar, it becomes horizontal when placed at the top or bottom of the Application Window or vertical when placed on the left or right side.

Using Docker windows

A Docker window is a dialog box that contains the same operations as most dialog boxes, e.g., command buttons, options, and list boxes.

Unlike most other dialog boxes, you can keep Docker windows open while working on a document to access the operations you use most frequently, or to experiment with different effects. Docker windows can be docked to any edge of the Application window, or you can undock them. When a Docker window is docked, you can minimize it so that it doesn't use up valuable screen real estate.
III. Creating New Drawings

To Create a Drawing

Do one of the following:

- Click the New Graphic icon on the Welcome To CorelDRAW screen.
- Click File, New.
- Click the New button.
- Select desired a layout size, or custom size such as height and width.
- Select unit desired and color mode
- Click OK
Opening Drawings

To Open a Drawing

Do one of the following:
- Click File, Open.
- Click the Open button.

1. From the Look In list box choose the drive where the file is stored.
2. Double-click the folder where the file is stored.
3. Double-click the filename.

To Open a recently Opened Drawing

1. Click File.
2. A list of the last four opened files appears at the bottom of the menu.
3. Click the file you want to open.

Saving, Closing, and Exiting

To Save a New Drawing

1. Click File, Save or Save As.
2. Choose a drive and folder where you want to save your drawing from the Save In list box.
3. Type a name in the File Name box.
4. Click Save.
To Save a Drawing that's been saved before

Do one of the following:
- Click File, Save.
- Click the Save button on the menu bar.

Closing Files

To close a file
- Click File, Close.

Exiting CorelDRAW

To exit
- Click File, Exit.

CorelDRAW asks if you want to save any unsaved changes in the open file(s):

1. Click Yes to save changes first and then exit the application.
2. Click No to exit without saving changes.
3. Click Cancel to close the dialog box and keep working on your drawing.

IV. Setting up the Page

From File Menu, New

To Choose a preset Page Size using the Property Bar

1. Click a blank space in the Drawing Window to deselect any objects.
2. Choose a preset paper size from the Paper Type/Size list box on the Property Bar.
To Choose a Preset Page Size

1. Click Tools, Options.
2. In the list of categories, double-click Document, double-click Page, and click Size.
3. Enable the Normal Paper button.
4. Choose a preset paper size from the Paper list box.

Setting the Page Orientation

To set the page orientation using the Options dialog box

1. Click Tools, Options.
2. In the list of categories, double-click Document, double-click Page, and click Size.
3. Enable the Normal Paper button.
4. Enable one of the following buttons:
   - Landscape, if you want the horizontal dimension of the page to be greater than the vertical dimension.
   - Portrait, if you want the vertical dimension of the page to be greater than the horizontal dimension.

Setting the Layout Style

To set the layout style

- Click Tools, Options.
- In the list of categories, double-click Document, double-click Page, and click Layout.
- Choose a layout style from the Layout list box.

V. Using the Grid, Rulers, and Guidelines

To Reposition the Rulers

Do one of the following:
- Hold down SHIFT, and drag the ruler to a new position.
- Hold down SHIFT, and drag the ruler intersection point to move both rulers simultaneously.

To Return a Ruler to its Previous Position

- Hold down SHIFT, and double-click the ruler.
Setting Ruler Units

To change the units of measurement on the rulers using the Options dialog box

1. Click Tools, Options.
2. In the list of categories, click Document, Rulers.
3. Do one of the following:
   - Enable the Same Units for Horizontal and Vertical Rulers check box.
   - Disable the Same Units for Horizontal and Vertical Rulers check box, and choose a unit of measurement for the vertical ruler from the Vertical list box.

Setting Grid Parameters

To set the distance between grid dots

1. Click Tools, Options.
2. In the list of categories, click Document, Grid or Guidelines.
3. Click one of the following buttons:
   - Frequency, to set the grid spacing as a number of dots per inch
   - Spacing, to specify the distance you want between each grid dot
4. Type values in the Horizontal and Vertical boxes.

To Display the Grid as Lines

1. Follow steps 1 to 3 in the previous procedure.
2. Click the Show Grid As Lines button.

Using Snap to Grid

To have objects snap to the grid using the Property Bar

1. Using the Pick tool, click a blank space in the Drawing Window to deselect all objects.
2. Click the Snap to Grid button on the Property Bar.
Displaying the Rulers and the Grid

- To display or hide the rulers using the Rulers command
- Click View, Rulers.
- If no check mark appears next to the command name, the rulers are hidden. If a check mark is there, the rulers are displayed.

To Display or Hide the Grid using the Grid command

- Click View, Grid.
- If no check mark appears next to the command name, the grid is hidden. If a check mark is there, the grid displayed.

Adding Guidelines

To add a Horizontal or Vertical guideline using the mouse

1. Click the Pick tool.
2. Click the Horizontal or Vertical ruler.
3. Drag the guideline to the Drawing Window.

To position a guideline using the mouse

1. Select the guideline with the Pick tool.
2. Drag the guideline to a new position.

Using Snap to Guidelines

To have objects snap to guidelines using the Property Bar

1. Click a blank space in Drawing Window to deselect any objects.
2. Click the Snap To Guidelines button on the Property Bar.

Displaying Guidelines

To display guidelines using the Guideline command

1. Click View, Guidelines.
   The command is enabled when it has a check mark beside it.
Deleting Guidelines

To delete a guideline using the keyboard

1. Select the guideline you want to delete with the Pick tool.
2. Press DELETE key.

To delete all guidelines

1. Follow steps 1 and 2 from the “To delete a guideline using the Guidelines Setup dialog box” procedure.
2. Click the Clear All button.

VI. Zooming and Panning

To Zoom in on a Portion of the Drawing

1. Open the Zoom flyout and click the Zoom tool.
2. Click and drag diagonally in the Drawing Window to create a marquee box around the area you want to magnify.

To See More of the Drawing

1. Open the Zoom flyout, and click the Zoom tool.
2. Do one of the following:
   - Click the area you want to magnify.
   - Right-click inside the Drawing Window, then click the zoom option you want.

To Move the Drawing within the Drawing Window

1. Open the Zoom flyout and click the Hand tool.
2. Drag the document to place it within the Drawing Window.
## Changing your View using the Property Bar

<table>
<thead>
<tr>
<th>To see ...</th>
<th>Do this (on the Property Bar) ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A magnified view of the drawing</td>
<td>Click the Zoom In button</td>
</tr>
<tr>
<td>More of the drawing</td>
<td>Click the Zoom Out button.</td>
</tr>
<tr>
<td>Objects at actual size</td>
<td>Click the Zoom Actual Size button.</td>
</tr>
<tr>
<td>All selected objects</td>
<td>Click the Zoom To Selected button.</td>
</tr>
<tr>
<td>All objects</td>
<td>Click the Zoom To All Objects button.</td>
</tr>
<tr>
<td>The entire Drawing Page</td>
<td>Click the Zoom To Page button.</td>
</tr>
<tr>
<td>The width of the Drawing Page</td>
<td>Click the Zoom To Page Width button.</td>
</tr>
<tr>
<td>The height of the Drawing Page</td>
<td>Click the Zoom To Page Height button.</td>
</tr>
<tr>
<td>The View Manager</td>
<td>Click the View Manager button.</td>
</tr>
</tbody>
</table>

## Changing your View using the Zoom and Standard toolbars

### To Display the Zoom toolbar
1. Click Window, Toolbars, More toolbars. Click on Command bars.
2. Enable the Zoom check box.

### To Jump to a Specific Magnification level in One Step

Do one of the following:
- Choose a magnification level from the Zoom Box control on the Standard toolbar.
- Type a value in the Zoom Box control.

## VII. Previewing a Drawing

### To Set the Full-Screen Preview View Quality
1. Click Tools, Options.
2. In the list of categories, click Workspace, Display.
3. Enable one of the following:
   - Use Normal View button, to specify the Normal view quality
   - Use Enhanced View button, to specify the Enhanced view quality
   - Use Enhanced View button and the Show PostScript Fills In Enhanced View check box, to display PostScript Fills
To View a Full-Screen Preview of the Current Page

1. Click View, Full-Screen Preview.

To View a Full-Screen Preview of Selected Objects only

2. Select the objects you want to preview.
3. Click View, and enable the Preview Selected Only command.

The command is enabled when it has a check mark beside it.
1. Click View, Full-Screen Preview.

To Return to the Drawing Window from any Full-Screen Preview

- Right-click or press any key.

VIII. Drawing and Shaping Objects

To Draw a Curve with the Freehand tool

1. Open the Curve flyout, and click the Freehand tool.
2. Position the cursor where you want the curve to start.
3. Drag along the desired path, as you would with a pencil on a piece of paper.
4. Release the mouse button to finish drawing the curve.

To Draw a Straight Line with the Freehand tool

1. Open the Curve flyout, and click the Freehand tool.
2. Click where you want the line to begin.
3. Click where you want the line to end.

Hold down CTRL as you place the end of the line to constrain the angle of the line to 15-degree increments. You can specify a different angle using the controls in the Options dialog box. For more information see "Controlling the behavior of the Freehand and Bezier tools."

To Draw a Closed Shape with the Freehand tool

1. Open the Curve flyout, and click the Freehand tool.
2. Draw a curve or a series of connected straight lines that begins and ends at the same point.

If you’re drawing a series of connected straight lines, double-click to create a node and click the starting point to close the shape. If you’re drawing a closed curve, drag over the starting point and release to close the shape.
Drawing Lines and Curves with the Bezier tool

To Draw a Curve with the Bezier tool

1. Open the Curve flyout, and click the Bezier tool.
2. Drag from the point at which you want to place the first node.
3. Drag from the point at which you want to place the next node. A segment appears between the two nodes you’ve created.

As you drag, two more control points appear. The position and angle of the control points affects the shape of the segment you’ve just created and the next segment you add (if you add one).

4. Repeat step 3 to add nodes to the curve.

To Draw a Straight Line with the Bezier tool

1. Open the Curve flyout, and click the Bezier tool.
2. Click where you want to place the first node.
3. Click where you want to place the next node.
4. Repeat step 3 for each node you want to add.

To Draw a Closed Shape with the Bezier tool

- Using the Bezier tool, draw a curve that begins and ends at the same node.

Drawing Rectangles and Squares

1. The Rectangle tool lets you draw rectangles and squares.
2. You can round the corners of a rectangle with the Shape tool or the Pick tool.
3. For more information see “Shaping ellipses and rectangles.”

To Draw a Rectangle

1. Click the Rectangle tool.
2. Position the cursor where you want the rectangle to appear.
3. Drag diagonally to draw the rectangle.

To Draw a Rectangle Starting from its Center

1. Click the Rectangle tool.
2. Position the cursor where you want the center of the rectangle to appear.
3. Hold down SHIFT then drag diagonally to draw the rectangle.
To Draw a Square

1. Hold down CTRL and drag diagonally.
2. Ensure that you release the mouse button before releasing CTRL.

Rounding the Corners of a Rectangle or Square

To Round the Corners of a Rectangle or a Square

1. Select the rectangle or the square with the Shape tool.
2. Drag one of the corner nodes along the outline of the rectangle or square.

As you drag, the four corner nodes each divide into two nodes with a round corner forming in between. As you continue to drag, the corners become increasingly round.

Drawing Ellipses and Circles

To Draw an Ellipse

1. Click the Ellipse tool.
2. Position the cursor where you want the ellipse to appear.
3. Drag diagonally to draw the ellipse.

To Draw a Circle

- Hold down CTRL and drag diagonally.
- Ensure that you release the mouse button before releasing CTRL.

Changing an Ellipse to an Arc or a Pie Shape

To Create an Arc or Pie Shape from an Ellipse (or circle)

1. Select the ellipse with the Shape tool.
2. Drag the node on the outline of the ellipse. To create an arc, keep the cursor outside the perimeter of the ellipse while dragging. To create a pie shape, keep the cursor inside the perimeter of the ellipse while dragging.

To Change the Direction in which Arcs or Pie Shapes are drawn

1. Select the arc or pie shape with the Shape tool.
2. Click the Clockwise/Counterclockwise Arcs or Pies button on the Property Bar.
Drawing Polygons and Stars

To Draw a Polygon

1. Open the Object flyout, and click the Polygon tool.
2. Position the cursor where you want the polygon to appear.
3. Drag diagonally to draw the polygon.

Hold down CTRL while dragging to draw a polygon with equal sides. Release the mouse button before you release CTRL.

4. If you want to change the number of sides on the polygon, type the appropriate number in the Number of Points on Polygon box on the Property Bar, then press ENTER.

To change the polygon to a star, click the Polygon/Star button on the Property Bar.

To Draw a Star

1. Open the Object flyout, and click the Polygon tool.

If a polygon or star is selected, press ESC to deselect it. Otherwise, step 2 will apply to the selected polygon or star.

2. Click the Polygon/Star button on the Property Bar.
3. Position the cursor where you want the polygon to appear.
4. Drag diagonally to draw the star.

Hold down CTRL while dragging to create a polygon with equal sides. Release the mouse button before you release CTRL.

4. If you want to change the number of points on the star, type the appropriate number in the Number of Points on Polygon box on the Property Bar, then press ENTER.

To change the star to a polygon, click the Polygon/Star button on the Property Bar.

To Draw a Star-Shaped Polygon

1. Open the Object flyout, and click the Polygon tool.

If a polygon or star is currently selected, press ESC to deselect it. Otherwise, step 2 will apply to the selected polygon or star.

2. Click the Polygon button on the Property Bar to select the polygon option.
3. Move the Sharpness slider on the Property Bar to the right or left to increase or decrease the sharpness of the polygon’s points (a polygon with no sharpness will not be star-shaped).
4. If you want to change the number of sides on the polygon, type the appropriate number in the Number of Points on Polygon box on the Property Bar, then press ENTER.
5. Drag diagonally to draw the polygon.

Hold down CTRL while dragging to create a polygon that has equal sides.

**To Change a Polygon to a Star or a Star to a Polygon**

1. Select the polygon or star with the Pick tool.
2. Click the Polygon/Star button on the Property Bar.

**To Change the Number of Sides of a Polygon or Points of a Star**

1. Select the polygon or star with the Pick tool.
2. Type a number in the Number of Points on Polygon box on the Property Bar, then press ENTER.

**To Change the Sharpness of a Star**

1. Select the star with the Pick tool.
2. Move the Sharpness slider on the Property Bar to the right to increase the sharpness, or move the slider to the left to decrease it. To access the Sharpness slider, a star must have at least seven points. The sensitivity of the slider increases with the number of points.

**Drawing Spirals**

**To Draw a Symmetrical Spiral**

1. Open the Object flyout, and click the Spiral tool.
2. Type a number in the Spiral Revolutions box on the Property Bar to indicate the number of revolutions you want for the spiral.

The spiral appears tighter when you use more revolutions. The default setting is four revolutions. The settings you select will remain until you change them.

3. Click the Symmetrical Spiral button on the Property Bar.
4. Position the cursor where you want the spiral to appear.
5. Drag diagonally to draw the spiral.
Drawing a Shape from the Center

To Draw a Shape from the Center
1. Click the drawing tool you want to use.
2. Hold down SHIFT and position the cursor where you want the center of the shape.
3. Drag diagonally to draw the shape.
4. Release the mouse button to finish drawing the shape, then release SHIFT.

To Draw a Shape, with Equal Sides, from the Center
1. Click the drawing tool you want to use.
2. Hold down SHIFT + CTRL.
3. Position the cursor where you want the center of the shape.
4. Drag diagonally to draw the shape.
5. Release the mouse button to finish drawing the shape, then release SHIFT + CTRL.

IX. Selecting an Object

To Select an Object
Using the Pick tool, click the object you want to select.

To Marquee Select Several Objects
Using the Pick tool, drag the mouse diagonally until a marquee box encloses all objects.

To Select All Objects
Do one of the following:
- Click Edit, Select All, Objects.
- Double-click the Pick tool.

Deselecting Objects
When you select an object you indicate that you want your next action to apply to that object. When you deselect an object, you indicate that you want to stop manipulating it and move on to another task.
To Deselect All Objects

Do one of the following:

- Click a blank space in the Drawing Window.
- Press ESC.

Moving Objects Interactively

To Move an Object Interactively

1. Select the object with the Pick tool.
2. Drag the object to a new place in your drawing.

Moving Objects in Increments

To Nudge an Object

1. Select the object with the Pick tool.
2. Press the Arrow key(s).

Sizing and Stretching Objects

To size an object using the mouse

1. Select the object with the Pick tool.

The object's selection box appears.

2. Drag one of the corner selection handles inward to decrease the size or outward to increase its size.

To Size an Object from its Center

1. Select the object with the Pick tool.

The object's selection box appears.

2. Hold down SHIFT, and drag one of the corner selection handles.
Rotating Objects using the Mouse

To Rotate an Object using the Mouse

1. Double-click the object with the Pick tool.

The rotation and skewing handles appear as two-way arrows. The center of rotation marker appears in the middle of the selection box.

2. Drag one of the rotation handles (the corner two-way arrows) in a clockwise or counterclockwise direction to rotate it.

To Reset the Center of Rotation Interactively

1. Double-click the object with the Pick tool.

The rotation and skewing handles appear as two-way arrows. The center of rotation marker appears in the middle of the box.

2. Hold down CTRL, and drag the center of rotation marker towards the middle of the object.
3. Release the mouse button to snap the marker to the object's center.

To Skew an Object using the Mouse

1. Double-click the object with the Pick tool.

The object's rotation and skewing handles appear.

2. Do any of the following:
   - Drag a horizontal skewing handle to skew the object left or right.
   - Drag a vertical skewing handle to skew the object up or down.

Mirroring Objects using the Mouse

To Mirror an Object using the Mouse

1. Select the object with the Pick tool.
2. Do one of the following:
   - To mirror an object horizontally, hold down CTRL and drag one of the side handles to the opposite side of the object from the left to right if you clicked the left side.
of the object, or right to left if you clicked the right side of the object.

- To mirror an object vertically, hold down CTRL and drag either the top or bottom handle of the object's selection box to the opposite side.
- To mirror an object diagonally, hold down CTRL and drag one of the corner handles of the object's selection box to the opposite side.

A dotted outline of the object appears when you reach the opposite side of the object.

3. Release the mouse button first and then release CTRL.

**X. Clearing Transformations**

**To Undo all Transformations applied to an Object**

1. Select the object with the Pick tool.
2. Click Arrange, Clear Transformations.

**To Redo all Cleared Transformations**

1. Select the object with the Pick tool.
2. Click Edit, Undo Clear Transformations.

**XI. Copying & Cutting Objects**

**To Copy an Object**

1. Select the object with the Pick tool.
2. Click Edit, Copy.

A copy of the object is placed on the Clipboard.

**To Cut an Object**

1. Select the object with the Pick tool.
2. Click Edit, Cut.

The object is removed from the drawing and placed on the Clipboard.
To Paste an Object from the Clipboard

1. Click Edit, Paste.

The contents of the Clipboard are placed in the Drawing Window. If the object was cut or copied from CorelDRAW, it is placed at the same location from which it was cut or copied.

Cloning objects

To Clone an Object

1. Click the object with the Pick tool.
2. Click Edit, Clone.

CorelDRAW places the cloned object in your drawing, slightly offset from the original. The default offset is 0.25 inches.

To determine a Clone's Master Object

- Right-click the object, and click Select Master.

To determine a Master Object's Clones

- Right-click the master objects, and click Select Clones. The Select Clones option is only available when a clone and master are on the same page.

Deleting Objects

To Delete an Object

1. Select the object with the Pick tool.
2. Click Edit, Delete.

To Cut an object

1. Select the object with the Pick tool.
2. Click Edit, Cut.
XII. Changing the Order of Objects on a Layer

<table>
<thead>
<tr>
<th>To Move the Selected Object...</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>To the front of its layer</td>
<td>Click Arrange, Order, To Front.</td>
</tr>
<tr>
<td>To the back of its layer</td>
<td>Click Arrange, Order, To Back.</td>
</tr>
<tr>
<td>Forward one position</td>
<td>Click Arrange, Order, Forward One.</td>
</tr>
<tr>
<td>Back one position</td>
<td>Click Arrange, Order, Back One.</td>
</tr>
<tr>
<td>In front of a specific object</td>
<td>Click Arrange, Order, In Front Of, then click the appropriate object.</td>
</tr>
<tr>
<td>Behind a specific object</td>
<td>Click Arrange, Order, Behind, then click the appropriate object.</td>
</tr>
</tbody>
</table>

Aligning Objects

To Align a Series of Objects

1. Select the objects with the Pick tool.
2. Click Arrange, Align and Distribute.
3. Click the Align and Distribute tab.
4. Enable the Top, Center, or Bottom check box to indicate how you want the objects to line up horizontally.
5. Enable the Left, Center, or Right check box to specify how you want the objects to line up vertically.

You can skip step 3 or 4 if you only want one type of alignment.

6. Do one of the following:
   - Enable Edge of Page or Center of Page to indicate where you want alignment to occur. Leave both boxes disabled if you want alignment to occur at the target object.
   - Enable Align To Grid if you want the objects to line up with the grid.

Locking Objects

To Lock an Object

1. Select the object with the Pick tool.
2. Click Arrange, Lock Object.

To Lock Multiple Objects or Groups of Objects

1. Hold down SHIFT, and select the objects with the Pick tool.
2. Click Arrange, Lock Object.
To Unlock an Object

1. Select the locked object with the Pick tool.
2. Click Arrange, Unlock Object.

To Unlock Multiple or Groups of Object

1. Select the locked objects with the Pick tool.
2. Click Arrange, Unlock All Objects.

Grouping Objects

To Group Objects

1. Select the objects with the Pick tool.
2. Click Arrange, Group.

To Ungroup Objects

1. Using the Pick tool, select any object in the group you want to ungroup.
2. Click Arrange, Ungroup (or Ungroup All, if required).

Combining Two or More Objects

To Combine Objects

1. Select the objects with the Pick tool.
2. Click Arrange, Combine.

To Break Apart Combined Objects

1. Select the combined object with the Pick tool.
2. Click Arrange, Break Apart.
Welding Objects

To Weld Objects

1. Select the objects with the Pick tool.
2. Click Arrange, Shaping, Weld.
3. Enable the Target Object check box if you want to keep a copy of the target object (the object to which you’re welding the selected object) after welding.
4. Enable the Other Object(s) check box if you want to keep a copy of the selected object(s) after welding.
5. Click Weld To.
6. Click the object you want to be the target object. (You can click one of the objects you selected in step 1.)

Trimming Objects

To Trim an Object

1. Using the Pick tool, select all the objects you want to use to trim the target object.
2. Click Arrange, Shaping, Trim.
3. Enable the Target Object check box if you want to keep a copy of the object you’re trimming.
4. Enable the Other Object(s) check box if you want to keep a copy of the objects you’re using to trim.
5. Click Trim.
6. Click the target object (the one you want to trim).

Intersecting Objects

To Intersect Objects

1. Select the objects with the Pick tool.
2. Click Arrange, Shaping, Intersect.
3. Enable the Target Object check box if you want to keep a copy of the target object.
4. Enable the Other Object(s) check box if you want to keep a copy of all other selected objects (except the target object).
5. Click Intersect With.
6. Click the object that you want to be the target object.
XIII. Adding Text

To Add Artistic Text

1. Click the Text tool.
2. Click anywhere in the Drawing Window, and type.
3. Do one of the following:
   • Click somewhere else in the Drawing Window to add more Artistic text.
   • Click another line of Artistic text to edit it.

To Select Specific Text with the Text tool

1. Click the Text tool.
2. Click at the beginning or end of a word or sentence in the Artistic text or Paragraph text frame.
3. Drag the cursor across the text you want to select.

To Select a Whole Text Object with the Text tool

1. Click the Text tool.
2. Click the X that appears in the center of the text object.

To Select Single Characters with the Shape tool

1. Open the Shape Edit flyout, and click the Shape tool.
2. Select the text with the Shape tool.

   Character nodes appear next to each character.

3. Click the node to the left of a character to select it.

To Select Multiple Characters with the Shape tool

1. Follow steps 1 and 2 from the previous procedure.
2. Do one of the following:

To Specify Formatting Properties using the Property Bar or the Text toolbar

1. Do one of the following:
   • Select the text with the Pick tool to format the whole text objecta line of Artistic text or all paragraphs in the Paragraph text frame.
   • Select the text with the Text tool to select specific characters.
2. Using the Property Bar or the Text toolbar, do one of the following:
   - Choose a font type from the Fonts List list box.
   - Choose a value from, or type a value in the Font Size List list box.
   - Click the Bold button.
   - Click the Italic button.

Creating Effects with Text

To Fit Text to a Path Directly
3. Click the Text tool.
4. Position the cursor near the object.
5. When the cursor changes to the insertion point cursor, click in your Drawing Window
6. Type the text along the object's path.

To Fit Text to an Open Path Object using the Fit Text to Path command
1. Using the Pick tool, select the object with an open path (e.g., a line or spiral).
2. Hold down SHIFT, and click the Artistic text.
3. Click Text, Fit Text To Path.
4. Choose an option for the orientation of letters on the path from the Text Orientation list box on the Property Bar.
5. Choose the vertical position of the Artistic text on the object from the Vertical Placement list box on the Property Bar.
6. Choose the horizontal position of the Artistic text on the object from the Text Placement list box on the Property Bar.

To Fit Text to an Object with a Closed Path using the Fit Text to Path command
1. Using the Pick tool, select the closed path object (e.g., ellipse, box, etc.).
2. Click Text, Fit Text To Path.
3. Choose an option for the orientation of characters on the path from the Text Orientation list box on the Property Bar.
4. Choose the vertical position of the Artistic text relative to the object from the Vertical Placement list box on the Property Bar.
5. Click the quadrant in which you want to place the Artistic text from the Text Placement list box on the Property Bar.

To Straighten Text
1. Select the text fitted to a path with the Pick tool.
2. Click Text, Straighten.
XIV. Outlines & Fills

To Apply a Uniform Fill using the Color Palette

1. Select the object with the Pick tool.
2. Click the color you want in the Color Palette.

To Apply a Two-Color Fountain Fill using the Fountain Fill dialog box

1. Select the object with the Pick tool.
2. Open the Fill Tool flyout, and click Fountain Fill Dialog.
3. In the Color Blend section, enable the Two Color button.
4. Choose the type of fountain fill you want from the Type list box.
   
   You can choose a linear, radial, conical, or square fountain fill.

5. Click the From color picker, then click the color you want at the start of the fountain fill's color progression.
6. Click the To color picker, then click the color you want at the end of the fountain fill's color progression.

   Click the Other button in the color list to create or choose a custom color.

7. Move the Mid-Point slider to set the mid-point between two colors.
8. Click one of the following buttons:
   
   - Direct, determines the intermediate fill colors according to hue and saturation changes along a straight line, beginning at the From color and continuing across the Color Wheel to the To color.
   - Clockwise Color Path, blends colors along a clockwise path around the Color Wheel.
   - Counterclockwise Color Path, blends colors along a counterclockwise path around the Color Wheel.

To Apply a Two-Color Pattern Fill using the Pattern Fill dialog box

1. Select the object with the Pick tool.
2. Open the Fill Tool flyout, and click Pattern Fill Dialog.
3. Enable the 2-color button.
4. Click the Pattern picker, then choose the pattern you want from the list that appears.
5. Click the Front color picker, and then choose a color for the bitmap pattern's foreground.
6. Click the Back color picker, and then choose a color for the bitmap pattern's background.
To Apply a Texture Fill using the Pattern Fill dialog box

1. Select the object with the Pick tool.
2. Open the Fill Tool flyout, and click Texture Fill Dialog.
3. Choose the library containing the texture you want from the Texture Library list box.
4. Choose a texture you want from the Texture list box.

The Preview window inside the dialog box displays the fill attributes that are assigned to the selected object.

5. Adjust the style options to customize the texture as required.

Click the Preview button to see the results of your modifications.

6. Click the Options button to adjust the bitmap resolution and texture size.

Applying Line Styles

To apply a Dashed Outline using the Outline Pen dialog box

1. Select the object with the Pick tool.
2. Open the Outline Tool flyout, and click Outline Pen Dialog.
3. Choose a line style from the Line Style selector.

To Apply a Dashed Outline using the Pen Roll-Up

1. Select the object with the Pick tool.
2. Open the Outline Tool flyout and click Pen Roll-Up.
3. Choose a line style from the Style selector.
4. Click the Apply button.

To Create Arrowheads and other Line-Ending Shapes using the Create Arrow command

1. Draw an arrowhead.

The arrowhead shape assumes the fill and outline attributes of the line to which it is applied.

2. Click the arrowhead shape with the Pick tool.
3. Click Tools, Create, Arrow.
4. In the Create Arrow with Selected Area dialog box, click OK to save the arrowhead.
XV. Creating Special Effects

To Create a Blend using the Interactive Blend tool

1. Click the Interactive Blend tool.

2. Drag the end handle of one of the objects you want to blend over the other object you want to blend, and release the mouse button.

The end handle appears after you start dragging the object.

To Create a Blend using the Blend Docker

1. Using the Pick tool, select the two objects you want to blend.
2. Click Effects, Blend.
3. Click the Apply button.

To Copy a Blend

1. Using the Pick tool, select the two objects to which you want to copy a blend.
2. Click Effects, Copy, Blend From.
3. Using the horizontal pointer that appears, select the blend you want to copy.

CorelDRAW automatically blends the objects you selected in step 1.

Contour Effects

To Add Contour Lines to the Center of an Object

1. Select an object with the Pick tool.
2. Click Effects, Contour.
3. Click the Steps tab.
4. Enable the To Center button.
5. Leave the default value or type a new value in the Offset box to indicate the space you want between the contour lines.
6. You can type values from 0.000 to 300.000 inches (or the equivalent in other units of measurement). The valid range depends on the size of the selected object.
7. Click the Apply button.
To Add Contour Lines inside an Object

1. Select an object with the Pick tool.
2. Click Effects, Contour.
3. Click the Steps tab.
4. Enable the Inside button.
5. Leave the default value or type a new value in the Offset box to indicate the space you want between the contour lines.

You can type a value from 0.000 to 300.000 inches (or the equivalent in other units of measurement). The valid range depends on the size of the selected object.

6. Leave the default value or type a new value in the Steps box to indicate the number of contour lines you want inside the object.
7. Click the Apply button.

To Set Color Progressions using the Contour Docker

1. Select a contoured object with the Pick tool.
2. Click Effects, Contour.
3. Click the Color Wheel tab.
4. Click the Outline color picker, then click the color you want at the end of the outline progression.
5. Click the Fill color picker, then click the color you want at the end of the fill progression.

If the original object has a fountain fill, a second color picker appears. Use this control to have a fountain fill at the end of the fill progression.

6. Click one of the following buttons to indicate how you want the outline and fill colors to progress through the color spectrum:
   - Direct
   - Clockwise
   - Counterclockwise

The black line on the Color Wheel shows the selected path.

7. Click the Apply button.

To Separate an Object from its Contour Lines

1. Select a contoured object with the Pick tool.
2. Click Arrange, Separate.

The contoured object is now two units: the original object and the group of contour lines.
To Ungroup the Contour Lines

1. Follow steps 1 to 2 from the previous procedure.
2. Select the contour lines with the Pick tool.
3. Click Arrange, Ungroup.

Distortion Effects

To Apply a Push Distortion

1. Open the Interactive Tools flyout, and click the Interactive Distortion tool.

2. Enable the Push And Pull Distortion button on the Property Bar. The button is enabled when it appears pressed.

3. Select the object to which you want to apply the distortion, and drag the mouse to the right to determine the amount of Push distortion you want to apply.

The point at which you click the object determines the center of the distortion.

To Apply a Pull Distortion

1. Follow steps 1 and 2 from the previous procedure.
2. Select the object to which you want to apply the distortion, and drag the mouse to the left to determine the amount of Pull distortion you want to apply.
To Apply a Zipper Distortion

1. Open the Interactive Tools flyout, and click the Interactive Distortion tool.
2. Enable the Zipper Distortion button on the Property Bar. The button is enabled when it appears pressed.
3. Select the object to which you want to apply the distortion, and drag the mouse to determine the amplitude of the zipper effect.

The point at which you click the object determines the center of the distortion.

4. In the Drawing Window, move the slider to determine the zipper frequency.

To Apply a Twister Distortion

1. Open the Interactive Tools flyout, and click the Interactive Distortion tool.
2. Enable the Twister Distortion button on the Property Bar. The button is enabled when it appears pressed.
3. Select the object to which you want to apply the distortion, and drag the mouse to the right along the X-axis, and up slightly along the Y-axis to apply a small amount of distortion.

Envelope Effects

To Reshape an Object using the Envelope Docker

1. Select an object with the Pick tool.
2. Click Effects, Envelope.
3. Click the Add New button. This places an enveloperepresented by a dotted box with squares as its nodes on top of the object and selects the Interactive Envelope tool (in the Toolbox).
4. Click one of the following buttons for the editing mode you want:
   - Straight Line
   - Single Arc
   - Double Arc
   - Unconstrained
5. In the Drawing Window, drag a node to change the shape of the envelope.

If you're using an editing mode other than Unconstrained, you can hold down CTRL or SHIFT as you drag to move the adjacent node an equal distance in the same or opposite direction, respectively. Hold down CTRL + SHIFT to have all four corner or side nodes (depending on the type you're dragging) move. If you're using Unconstrained editing mode, you can hold down CTRL to limit node movement horizontally or vertically.

6. Repeat steps 4 and 5 until the envelope is the shape you want.

To Reshape an Object using the Interactive Envelope tool

1. Open the Interactive Tools flyout, and click the Interactive Envelope tool.
2. Select the object to which you want to apply an envelope.
3. Click the button on the Property Bar that indicates the editing mode you want.

You can choose Straight Line, Single Arc, Double Arc, or Unconstrained editing mode.

4. Drag a node to change the shape of the envelope.

If you're using an editing mode other than Unconstrained, you can hold down CTRL or SHIFT as you drag to move the adjacent node an equal distance in the same or opposite direction, respectively. Hold down CTRL + SHIFT to have all four corner or side nodes (depending on the type you're dragging) move. If you're using Unconstrained editing mode, you can hold down CTRL to limit node movement horizontally or vertically.

5. Repeat steps 3 and 4 until the envelope is the shape you want.

To Create an Envelope from an Object in your Drawing

1. Using the Pick tool, select the object to which you want to apply the envelope.
2. Click Effects, Envelope.
3. Click the Eyedropper button.
4. Using the horizontal pointer that appears, select the object you want to use as the basis for the envelope.

CorelDRAW adds an envelope to the object you selected in step 1. This envelope has the same shape and dimensions as the object you selected in step 4.

5. Click the Apply button.

To Remove an Envelope

1. Using the Pick tool, select the object that has the envelope you want to remove.
2. Click Effects, Clear Envelope.
Extrude Effects

To Extrude an Object using the Extrude Docker

1. Select an object with the Pick tool.
2. Click Effects, Extrude.
3. Click the Vanishing Point Page tab.
4. Choose an extrusion type from the top list box.
5. Choose a vanishing point option from the bottom list box.

If no vanishing point option applies (as is the case with rotated extrusions), this list box appears dimmed. For more information, see "Locking an extrusion’s vanishing point" and "Copying and sharing vanishing points."

6. Drag the vanishing point marker (represented by "X") to set the depth and direction of the extrusion. Or, click the Page Flipper button to display controls for placing the vanishing point at a precise coordinate.

If you’re creating a perspective extrusion, you can also set the depth by typing a value in the Depth box.

7. Click the Apply button.

Lens Effect

To Create a Transparency Lens

1. Using the Pick tool, select the object to which you want to apply the lens.
2. Click Effects, Lens.
3. Choose Transparency from the list box in the Lens Docker.
4. Type a percentage value from 0 to 100 in the Rate box to specify the rate of transparency.

As you increase the value, the object becomes more transparent. At 100%, the lens fill disappears.

5. Click the color picker, then click the fill color you want for the lens.

You can also leave the default color that is already displayed on the color picker.

6. Click the Apply button.
To Move a Lens's Viewpoint

1. Select the lens with the Pick tool.
2. Click Effects, Lens.
3. Enable the Viewpoint check box in the Lens Docker.

At this point, the Edit button appears to the right of the check box.

4. Click Edit to display the viewpoint marker (represented by an “X”) in the Drawing Window.
5. Drag the viewpoint marker to the desired position.
6. Click the End button.
7. Click the Apply button.

To Remove a Lens

1. Select the lens with the Pick tool.
2. Click Effects, Lens.
3. Choose No Lens Effect from the list box in the Lens Docker.
4. Click the Apply button.

XVI. Powerclip Effect

To Create a PowerClip Object

1. Using the Pick tool, select the object you want to use as the contents.
2. Click Effects, PowerClip, Place inside Container.
3. Using the horizontal pointer that appears, select the object you want to use as the container.

The contents object is placed inside the container object. The contents and container now becomes a single unit.

To Extract the Contents of a PowerClip Object

1. Using the Pick tool, select the PowerClip object whose contents you want to extract.
2. Click Effects, PowerClip, Extract Contents.
XVII. Perspective Effect

To Add a One-Point Perspective Effect to an Object

1. Select the object with the Pick tool.
2. Click Effects, Add Perspective.

A grid box with four nodes (at the corners) appears around the object. The Shape tool is now selected.

3. Hold down CTRL and drag one of the nodes horizontally or vertically.

By holding down CTRL, you constrain the node's motion to its horizontal or vertical axes to create a one-point perspective. Hold down CTRL + SHIFT as you drag to move opposing nodes the same distance in opposite directions.
To Add a Two-Point Perspective Effect to an Object

1. Select the object with the Pick tool.
2. Click Effects, Add Perspective.
3. Drag one of the grid box nodes diagonally toward or away from the object's center.
4. Repeat step 3 using the other nodes until you create the perspective effect you want.

To Remove an Object’s Perspective Effect

1. Select the object with the Pick tool.
2. Click Effects, Clear Perspective.

XVIII. Drop Shadow Effect

To Add a Drop Shadow to an Object

1. Open the Interactive Tools flyout, and click the Interactive Drop Shadow tool.
2. Select the object to which you want to apply a drop shadow, and drag the end fill handle to position the drop shadow.

XIX. Discover Raster Editing Features

Discover Raster Editing Features

CorelDRAW Graphics Suite X5 offers a large number of features to effectively and efficiently manipulate many raster formats.

RAW Camera File Support

When importing RAW files directly from your digital camera, you can view information about file properties and camera settings, adjust image color and tone, and improve image quality. Interactive controls let you preview changes quickly.
Image Straightening Lab

The Straighten image dialog box lets you straighten bitmap images quickly. This feature is useful for straightening photos that were taken or scanned at an angle.

Histogram Feedback

Edit images more efficiently by previewing changes and comparing results in real time as you adjust image tone, apply effects or process RAW camera files.

Image Adjustment Lab

The Image Adjustment Lab consists of automatic and manual controls, which are organized in a logical order for image correction. By starting in the upper-right corner and working your way down, you can select only the controls you need to correct the problems specific to your image. It is best to crop or retouch any areas of the image before beginning the color and tone corrections.

Importing and Exporting Files

CorelDRAW allows you to import or export a wide variety of file formats.

Importing Files

CorelDRAW lets you import files (Ctrl+I) created in other applications. For example, you can import a Portable Document Format (PDF), JPEG, or Adobe® Illustrator® (AI) file. You can import a file and place it in the active application window as an object. You can also resize and center a file as you import it. The imported file becomes part of the active file.
While importing a bitmap, you can resample it to reduce the file size, or crop it to eliminate unused areas of the photo. You can also crop a bitmap to select only the exact area and size of the image you want to import.

To make importing easier, you can sort the file types by most recent, extension, text or description.

**Exporting Files**

You can export (Ctrl+E) and save images to a variety of file formats that can be used in other applications. For example, you can export a file to the Adobe Illustrator (AI) or GIF format.

Some file formats may not support all the features that a CorelDRAW (CDR) file has, so it is a good idea to save the original file as a CorelDRAW (CDR) file before exporting it.

**XX. Exercises**

**Creating a Pendant**

1. Draw the outline of the basic shape using Bazier Tool.

2. Edit the basic shape using Shape Tool with Node Edit Options.

3. Create the offset shape inside the original shape using Interactive Contour Tool.

4. Fill it with Golden shade using Fountain Fill > Preset

5. Make different shapes according to requirement.

6. Use Shift + Pick Tool and Right click to get the smaller copies. You can try Interactive Contour Tool.
7. Try the combination of the shapes.

8. After filling the golden shade, change the direction of the fill by shifting the arrow using Interactive Fill Tool.

9. Place the shapes in a proper symmetry

Making Rings

1. Draw perfect circle with the help of Ellipse Tool and CTRL key.
2. With Shift and Drag method, make a copy of the circle inside the main circle and right click to get the copy.
3. Select both the circles

   Arrange > Combine


5. With the proper combination of two colors create the ring effect. White is chosen as a mid-color in the following ring.

6. How to entangle the rings? Make another copy of the ring. Place is over other.
7. Draw the shape which you want to remove to get entangled effect on the top cross section of the rings.

![Entangled rings](image)

8. Select the newly drawn shape. Arrange > Shaping > Trim

9. Click on the top circle to trim. Delete the shape after trimming.

![Trim dialog box](image)

---

**Explode**

1. Select Graph Paper Tool from Tool Box. Add the number of rows and column using Property Bar. Input the same values for rows and cols.
2. Press CTRL and draw square shaped graph paper.
3. Select Ellipse Tool and draw perfect circle by pressing CTRL.
4. Place the circle above the graph paper in the middle. Select the circle.

![Graph paper and circle](image)

5. Effects > Lens
   - Select Fish Eye from drop down menu. Check Frozen. Click Apply.

![Fish Eye dialog box](image)
6. Select the graph paper and delete it.  
   Select the ball.  
   Arrange > Ungroup  
   Select the outside circle and delete.

7. Select any portion of the ball and keep on pressing Tab till one more circle behind the ball get selected.  
   Delete that circle also.

8. Select the ball and fill the color.
9. Move the parts of the ball to create Explode effect.

Creating Yahoo Style Buttons

1. Begin by drawing a circle. Holding down the CTRL key while dragging the cursor will assure you of a circular rather than an elliptical (oval) shape.
2. Repeat the process drawing a smaller circle this time. Use the Pick tool to marquee select both circles.
3. Choose Arrange, Align and Distribute and, in the Align and Distribute dialog box click on the "Center of Page" option. Click OK.
4. Select the Pick tool and click on the outer circle to select it.
5. Place the mouse over the Fill tool and hold down the left button until the flyout menu appears. Select the Fountain Fill Dialog icon. This will bring up the Fountain fill dialog box.
6. Set the Type to Linear and the Angle to -45%. Leave the Color Blend as Two color (the From: color should be black and the To: color should be white). Click OK and your image should resemble.

7. Use the Pick tool to select the inner circle.
8. Bring up the Fountain Fill Dialog box again. This time set the Type to Radial, set the Horizontal Offset to -20 and the Vertical Offset to 20.
9. Left-click on the From: color. This will bring up a small menu of colors. Choose the color you want the button to be: I chose a dark blue. Click OK.

10. That's it for the button. You can add text or clip-art images. Place some text in a circle over the top of the button, shrunk it down, and saved it as the web-ready JPG.

11. Make sure you keep a copy of the vector drawing i.e. save the image as a CDR file so you can go back and make changes easily later on.
Creating a Page Curl Effect

1. Draw a rectangle. Once you’ve drawn the rectangular shape, fill it with a bright yellow.

2. Draw another rectangle that’s long and narrow. Place this rectangle along the bottom of the first and turn it so that it covers the two corners of the yellow rectangle and so that it’s on an angle.

3. Use the Pick tool to draw a marquee around both of the shapes.

4. Along the toolbar (the second line below the menu choices) you should see the trim icon. Click this icon to trim the top rectangle (the last rectangle shape you created) from the bottom rectangle (the yellow one that you created first).

5. Click away from the two shapes to de-select them. Select the long rectangle and press the delete key to discard it. You should now have just the bottom portion of the sticky note (a rectangle shape with an angled bottom).

6. Double click the Polygon tool and, in the Options dialog box, choose the Toolbox tab. Under Polygon Tool Defaults set the Polygon option and set the number of Points/Sides to 3. This will enable you to draw a triangle.

7. Draw a long narrow triangle shape beside the yellow rectangle.
8. Choose Layout, Snap to Objects.

9. Select the Pick tool and click twice on the triangle to set the rotation points. Move the center of rotation point to the top point of the triangle. Click the triangle again to set the sizing points. Move the triangle so that the top point is aligned with the bottom-left corner of the sticky note. Click the triangle again to change to the rotation points. Click on one of the corner rotation points and drag the triangle until it aligns with the bottom of the sticky note.

10. With the triangle still selected, choose Arrange, Convert to Curves.

11. Select the Shape tool. Select the node in the middle of the right side of the triangle and press the delete key to discard it.

12. With the Shape tool, marquee selects the two right corners of the triangle and click on the To Curve icon on the toolbar.

13. Place the cursor in the middle of the line along the right side of the triangle and drag it to the left until you get a nice rounded curve.

14. If you need to, you can stretch the triangle shape so that it fits along the bottom of the rectangle. Just select the Pick tool and click on the triangle, then stretch it to fit. With the “Snap to Objects” still on this should be relatively easy.

15. Now you should have both shapes of the sticky note. The yellow note, itself, and the triangle that’ll become the page curl.

16. All that's left to do is use a fountain fill to blend some shadows and highlights onto the triangle to give the appearance of a 3-dimensional curve.

17. Use the Pick tool to select the triangle shape.
18. Click-and-hold the Fill tool icon. This will bring out the Fill tool flyout. Select the Fountain Fill Dialog icon.

19. In the Fountain Fill dialog set the Type to Linear and click the Custom button.

20. You're going to have to play around with the Angle, the Edge Pad and the placement of the colors to come up with a fill that fits your particular triangle.

21. To start, set the left-most color to a bright yellow. Click on the Current option and then select Others. Set the color to a darker yellow. I chose 0, 0, 75, 24.

22. Click along the top of the gradient about a quarter of the way out from the left end and click the bright yellow color square in the colors swatch. Click a little ways over to the right and choose white. Click a little over again and select the bright yellow again. Finally, set the color at the far right to a dark yellow.

23. Set the Angle to about -45% and the Edge Pad to 20.

24. You should have similar settings to those shown image.

25. Click OK.

26. You may find, like I did, that the fill doesn't give you the effect you expected. If this is the case, bring up the Fountain Fill dialog box again. If the white line wasn't visible move the two yellows and the white over and click OK.

27. Once the white and yellow lines are visible you can adjust the angle, as well.

28. You may find that you'll need to add another color such as another dark yellow close to the left edge of the bright yellow/white lines.

29. It should only take a couple of minutes of fine tuning to get the effect just right.

30. Marquee select both shapes and select the Outline tool. Hold down the mouse button until the flyout appears. Select the No Outline option.

31. You'll now have a yellow sticky note with a curled-up corner.

32. Now, because this is a vector image, you can easily resize it, and add some text as I've done. The final image can then be saved as a web-ready JPG.
33. Note that you can use similar techniques to add a curled effect to any image you want. You would, of course, choose different colors.

34. Make sure you keep a copy of the vector drawing i.e. save the image as a CDR file so you can go back and make changes easily later on.

**Adding a Texture**

1. Select text tool and type the text preferably using thick font. We have used Impact.

   **Note:** It is expected that you have finished with the beginners projects when you start with intermediate, as we do not repeat the small instructions.

2. Select Interactive Extrude Tool from the flyout menu from the tool box. Its 10th from the top.

3. Create the 3D effect using Interactive Extrude Tool. Keep the text selected.

4. From the Property Bar at the top select Lighting.
5. Try out different options for lighting and create following effect.

![3D PHOTO](image)

6. From the Fountain Fill flyout menu select the Texture Fill Dialog.

![Texture Fill Dialog](image)

7. Apply the desired texture to the text.

![3D PHOTO with Texture](image)

Creating a Sunset

1. Open Corel DRAW.

2. Draw the rectangle with Rectangle Tool to create the cloud effect. Remove outline.

3. Select Interactive Fill Tool. Drag from Top to Bottom.

4. Fill Black, Red and Yellow color from top to bottom and adjust the proportion properly.

5. Select the rectangle. Drag it down with Top Center point to get the mirror image of the original. Without leaving left button, click right mouse button to get the copy of the mirror image which will be used as a lake.

![Sunset Effect](image)
6. Draw mountains with Bezier Tool and fill it with black color.

7. Follow the step 5 to get the mirror image of the mountains

8. Send the mountains behind the lake.


10. You will get the reflection of the mountains.
11. Draw Land with Bezier Tool

12. Draw Coconut tree with Bezier Tool.

13. Group the branches and copy them to create two more trees.

14. The output will look like this.
15. Draw the Boat with Bézier tool and group it. Make the reflection of it using previous mountain steps and send the reflection behind the Lake.

16. The output will look like this.

17. Create Circle with Ellipse Tool fill it with Interactive fill tool using Radial Fountain Fill. This will make Sun. Use the combination of red and yellow color.

18. Send the Sun behind mountains.

19. Duplicate and get the copy of sun. Stretch it horizontally and make it thin vertically.

20. Keep on duplicating and place it one below other.

21. Make the size of the copy small as you go downwards.

22. This will create the reflection of the Sun in the lake.
Fitting the Text to Path

Fitting text to path means that a line of text is bound to follow the path of an object. You can fit Artistic text to open and closed paths.

1. Using the Pick Tool, click to select the path you want to text to fit.
2. Click Text on the menu bar, then click Fit Text to Path.
3. Type the Text: Informatics Computer Institute

To Fit Text to Path interactively, follow these steps:

1. Using the Pick Tool, click to select the path you want text to fit to
2. Click Text Tool
3. Move your mouse over the path, click the path as soon as the mouse pointer changes into a Fit to Path
4. Type the Text

Separating the Text from a Path

1. Using the Pick Tool, click to select the text fitted to a path.
2. Click Arrange on the menu bar, then click Separate.
You can then move and separate the text from the path.

Adjusting the Distance between the Text and the Path

1. Using the Pick Tool, click to select the text fitted to a path
2. On the Property Bar, type the value you want at the Distance from Path box or click the appropriate arrow to find the value you want.
3. Press Enter on your keyboard

Adjusting the Horizontal Offset

1. Click the Text Tool
2. Click at the beginning of the text fitted to path. (Or click the text then use the arrow keys to place the cursor at the beginning of the text as illustrated).
3. Press the Space Bar on your keyboard repeatedly until you arrive at the position you want.
You can also adjust the horizontal offset by following these steps.

1. Using the Pick Tool, click to select the text fitted to a path.
2. On the Property Bar type desired value at the Horizontal Offset box, Or click the appropriate arrow until you arrive at the right Horizontal Offset value.

Adjusting the Horizontal Spacing

1. Click the Shape Tool
2. Click the text fitted to a path
3. Drag the Interactive Horizontal Spacing Arrow to the right until you arrive at the spacing result you want.

Adjusting the Text Orientation

1. Using the Pick Tool, click to select the text fitted to a path
2. On the Property Bar, click the Text Orientation you want
Adjusting the Vertical Placement of Text

1. Using the Pick Tool, click to select the text fitted to a path.
2. On the Property Bar, click the Text Orientation you want.

Adjusting the Text Placement

1. Using the Pick Tool, click to select the text fitted to a path.
2. On the Property bar, click the Text Orientation you want.

Positioning the Text on the Opposite side of the Path

1. Using the Pick Tool, click to select the text fitted to a path.
2. On the Property bar, click the place on the Other side button.

Applying 3D Effects

1. Creating Perspective Effect

We will begin to create the Perspective Effect.

a. Go to the "Text Tool ", you can found it on the left toolbar, create a text object by left click on the screen and type any word you want, use any thick type of font which you will use in this exercise.

b. Select the font object, and press " Alt + A + B " to break the font spacing.

c. After it breaks, arrange the web text into the bottom of the text.

d. After that, select all the text and convert it into object by pressing " Ctrl + Q " it will be easier to modify.

e. Select all the objects and go to the upper toolbar, there you will see the " Weld, Trim, Intersect " Tool.

f. Press Weld in order to weld it.
g. Create a line around the object using "Contour Tool".
h. Select the object and go to the Contour Tool, it's in the left toolbar, after that go to the upper toolbar, there you will see an option contour dialog, make the contour type Outside Curve, Contour Offset 0.1 cm, and the outside color Red and Fill color yellow.

i. Apply the perspective effect into the object.
j. Go to the Top toolbar and find Effect > Add Perspective.
k. There will be an perspective points on the corner, Drag the perspective point to make an angle. Apply it as picture below.
2. Creating the Extrude Effect

a. After the perspective is applied, we need to separate the outline from the object.
b. Go to the Top Toolbar, and find Arrange > Break Contour Group Apart.
c. This will separate the outline and the object.
d. Then select the Outline and go to the "Interactive Extrude Tool" in the left toolbar.
e. Hold and Drag the outline to create an extrude effect, to be more accurately please apply the value below.
f. We are going to put color in the text object.
g. Select the text object, go to the “Fountain Fill Tool” in the left toolbar, Choose Custom fill on the color blend and make the type Linear.
h. Now you will see a color box. You can change the color by left-clicking it, fill the color with Light Yellow on the left, middle and right side of the color box.
i. You can make a custom fill by double-clicking at the color box.
j. Fill the color with Gold on the middle left, and another Gold on the middle right.
k. Custom colors in the middle will make the color gradient softer.
l. Make the Gradient Angle to 270, which will make the gradient horizontal.

![Image of Fountain Fill Tool]

m. Put color on the front extrude object.

n. Select the Front Extrude object, and go to the “Fountain Fill Tool”.

o. Using the same way as above applies the value as in picture below. (color: red, dark red, red, dark red, red)
p. After that we are going to put color on the bottom Extrude Object,

q. Select the bottom Extrude Object and go to the "Fountain Fill Tool".

r. Using the same ways as above apply the value as in picture below.
s. Now copy the Text Object by pressing " Ctrl + C " and paste " Ctrl + V ".

t. Put a black color in it and press " Ctrl + PageDown " to send it to back.

3. Creating the Glowing Effect

a. To make it more realistic, we are going to put a Glowing Effect into the text object.

b. Apply it per letter, select the " e " on the text object, and copy it.

c. After that put a white color in it.

d. As the color is white, I will make a temporary red background so we can see the object.
e. After that select the "e", and go to the "Interactive Transparency Tool" in the left toolbar.

f. Now you will see that the cursor are changing into a glass object, Hold and Drag it from the right corner to middle of the "e" object to create a transparency effect.

![Transparency Example](image1.png)

g. After it applied into all the letters, we are going to add more glowing effects on it.

h. Create a tiny circle on the side of the object, using "Ellipse Tool" in the left toolbar.

i. Now select the tiny circle, and go to the "Interactive Drop Shadow" tool in the left toolbar.

j. Hold and drag it on top of the Transparency object.

k. After that go to the upper toolbar, there you will see an shadow option, set the shadow opacity into 80 and shadow feathering into 60.

![Glowing Effects Example](image2.png)
I. Apply it using same way as above to all the letters.
4. Creating the Background

a. Create the background for 3D Object.

b. Create a box shape, using "Rectangle Tool" in the left toolbar.

c. Resize it to be as same size as our worksheet, which is an 8-1/2" x 11" inch.

d. Now put a color in it using the "Fountain Fill Tool" and apply black and gray.

e. Now put the 3D Object on top of the background.

f. After that go to the "Bezier Tool" its in the left toolbar, draw a shape by point & left click to create a custom shape on top of the background like in the picture below.

g. Make sure that the last click is connected with the first click or else you cannot put color on the shape.
h. Put a color in it by go to the "Fountain Fill Tool" and apply the values black gray black.

i. After that draw another similar custom shape using "Bezier Tool" as in picture below. (color: white, gray, white, gray, white)
j. Another similar custom shape using “Bezier Tool” as in picture below. (color: red, dark red, red, dark red, red).

k. Put a color in the last custom shape by go to the “Fountain Fill Tool” and apply the value below.
5. Working with Powerclip

a. Now we are going to insert the Custom Shape into the Background using "PowerClip"

b. Left-click all the Custom Shape, and then go to the top toolbar and find Effect > Powerclip > Place Inside Container.

c. Then you will see a black arrow, Left-click it to background, and now you will see that the Custom Shape is inside the Background.

d. You can go "inside" or "outside" the container by holding Ctrl while double-clicking it.
6. Adding More Background

- a. Now let's create more background to make it more interesting.
- b. Create a box using "Rectangle Tool."
- c. Go to the "Shape Tool" in the left Toolbar, find the corner of the box and drag it to customize the corner.
- d. Copy and paste the box, make it 3 in a row and column.
e. Now select all the boxes, and go to the "Interactive Envelope Tool" in the left toolbar.

f. After that go to the upper toolbar, there you will see an envelope option.

g. Make the envelope type into Single Arc mode, Hold and drag the middle point to shape.

h. Shape it like in the picture below.

i. Apply the perspective effect into the object.

j. Go to the Top toolbar and find Effect > Add Perspective.

k. There will be a perspective points on the corner, Drag the perspective point to make an angle.
I. Now put the object behind the 3D Effect Object.

m. Here is the Final Image
Creating a Logo

![Logo Image]

Creating the background

To start making the logo, you will first create a new, blank document. Next, you will create triangles that form the shape of the background by using the Smart drawing tool. Then, you will rotate, mirror, and move the triangles into position, and finally, you will create the decorative circles for the logo.

To create triangles for the background

1. Click File menu, New.
2. In the toolbox, click the Zoom tool
3. From the Zoom levels list box on the standard toolbar, choose To width.
4. In the toolbox, click the Smart drawing tool
5. From the Shape recognition level list box on the property bar, choose Highest.
6. From the Smart smoothing level list box, choose Medium.
7. Choose 1.0 pt from the Outline width list box on the property bar.
8. In the Outline Pen dialog box, ensure the Graphic check box is enabled, and click OK.
10. Draw a smaller triangle.
11. In the toolbox, click the Pick tool
12. Click the smaller triangle and drag it to place it inside the larger triangle.
13. Click Edit menu, Select all, Group Objects.
14. Click Arrange menu

When objects are grouped, you can manipulate them as a single object. This is what the triangle group looks like:

To arrange the triangles to create the background

1. Click View menu

2. Click the Pick tool
   a. Snap to objects.
   b. And select the triangle group.
   c. On the property bar, type 45 and press Enter.

3. In the Angle of rotation box

4. Click Edit menu
   a. Duplicate to create another triangle group.

5. In the Duplicate offset dialog box, type a value in the Horizontal offset and vertical offset boxes, and click OK.

This lets you define the offset for the duplicate in relation to the original. At any time, you can modify the duplicate offset distances by choosing Tools menu Options Document General.

6. Click the Mirror horizontal button on the property bar.

7. Drag the duplicate triangle group to the right of the first group. Make sure their corners are touching.

8. Click Edit menu

9. Select all
   a. Duplicate.
   b. On the property bar.
   c. Objects.

10. Click the Mirror vertical button

11. Drag the duplicate triangle groups below the first set. Make sure their corners are touching.
This is what the drawing should look like:

To create decorative circles for the background

1. In the toolbox, click the Ellipse tool
2. Drag to create an ellipse on a blank area of the drawing. If you want to draw a perfect circle, you can hold Ctrl to constrain the shape as you draw it.
3. Click the Pick tool and select the circle.
4. Drag the circle to the edge of one of the triangle groups. Place it between the top and the bottom of the triangle. Please refer to the image that follows this procedure to see where to place the circles.
5. Click Edit menu Duplicate. Repeat this step until you have 5 additional circles. You need a total of 6 circles.
6. Drag the remaining circles to the edges of the triangle groups. Place each circle in between the top and bottom of the triangle.

This is what the drawing should look like:

Adding Color

Now that the basic shape for the logo is complete, you can add color to it. The design for The Coffee Shop logo uses three colors. You will add olive green to the outer triangles, deep yellow to the inner triangles, and light yellow to the circles.

There are different color models you can use to choose colors from, such as grayscale, CMYK, or RGB. The CMYK color model is used for creating images you intend to print later, and it ensures high-quality color printing. The RGB model, on the other hand, is optimized for the screen. For this project, you will use the RGB color model.
To Add Color to Outer Triangles

1. Click Edit menu  Select all  Objects.
2. Click Arrange menu
3. Click the Pick tool  Ungroup all.
4. Hold down Shift, and select the four outer triangles.
5. Open the Fill flyout and click the Fill color dialog button
6. Click the Models tab.
7. From the Model list box, choose RGB.
8. In the R box, type 153.
9. In the G box, type 153.
10. In the B box, type 51.
11. Click OK and click the Fill color dialog button

To Add Color to the Inner Triangles

1. Click the Pick tool
2. Hold down Shift, and select the four inner triangles.
3. Open the Fill flyout and click the Fill color dialog button
4. Click the Models tab.
5. From the Model list box, choose RGB.
6. In the R box, type 255.
7. In the G box, type 204.
8. In the B box, type 0.
9. Click OK and click the Fill color dialog button

To Add Color to the Circles

1. Click the Pick tool
2. Hold down Shift, and select the six circles.
3. Open the Fill flyout and click the Fill color dialog button
4. Click the Models tab.
5. From the Model list box, choose RGB.
6. In the R box, type 255.
7. In the G box, type 249.
8. In the B box, type 116.
9. Click OK.

This is what the drawing should look like:

Creating the Diamond Shape

To make the coffee cup stand out from the background, the logo uses a diamond shape overlying the background for the coffee cup. The diamond shape consists of two overlapping squares, one slightly smaller than the other, which are grouped and then rotated 90 degrees to form the diamond.

To Create the Outer Square

1. Using the Rectangle tool, drag to create a square on a blank area of the drawing. The square should be smaller than the background, but big enough to cover the middle of the background. If you want an exact square, you can hold down Ctrl to constrain the shape as you draw it.
2. From the Shape edit flyout, click the Shape tool
3. Drag a corner node to round the corner of the square.

To Create the Inner Square

1. Click the Pick tool and select the square
2. Click Edit menu Copy
3. Click Edit menu and select the square. Copy and Paste to place a duplicate of the square on top of the original square. The topmost square completely covers the original square.
4. Click the Pick tool.

5. Hold down Shift and drag one of the corner selection handles until the square is slightly smaller than the original square.

   By holding down Shift, you are resizing the square from its center.

**To Add Color to the Outer Square**

1. Select the larger square using the Pick tool

2. On the color palette, click a Red color swatch. If you didn’t move the color palette, it should be docked on the right side of the workspace.

3. In the Outline width box square a thicker outline on the property bar, type 2.5 and press Enter.

**To Add Color to the Inner Square**

1. Select the smaller square using the Pick tool

2. Open the Fill flyout, and click the Fill color dialog button

3. Click the Models tab.

4. From the Model list box, choose RGB.

5. In the R box, type 229.

6. In the G box, type 255.

7. In the B box, type 229.

8. Click OK to fill the square with the specified color.

9. In the Outline width box on the property bar, type 2.5 and press Enter to give the square a thicker outline.

This is what the drawing should look like:
To Rotate the Squares to Create Diamonds

1. Select the smaller square using the Pick tool
2. Hold down Shift, and click the larger square. Both squares are now selected.
3. Click Arrange menu, Group to group the two squares. On the property bar, type 45 and press Enter.
4. In the Angle of Rotation Box

This rotates the squares to create a diamond shape. This is what the drawing should look like:

1. Drag the resulting diamond shape on top of the background. If the diamond shape is too large or too small, resize the diamond by dragging one of the corner selection handles.

This is what the drawing should look like:
Adding the Coffee Cup and Drop Shadow

Now that you have created the diamonds, you can add the coffee cup to the logo. The coffee cup already exists as a CorelDRAW (CDR) file. To add the coffee cup, you will import the coffee cup file.

To make the coffee cup stand out from the rest of the logo, you can add a drop shadow by using the Interactive drop shadow tool. The drop shadow gives the illusion that the coffee cup is floating above the rest of the logo, giving the image more depth.

To Import the Coffee Cup

1. Click File menu Import.
2. From the Files of type list box, choose CDR - CorelDRAW.
3. Your instructor will give the sample cup file.
4. Choose the filename cup.cdr.
5. Click Import.
6. Position the pointer on a blank area of the drawing page, and click to place the coffee cup graphic.
7. Drag to center the coffee cup graphic on top of the diamond shape.

If the graphic is too large or too small, resize it by dragging one of the selection handles.

This is what the drawing should look like:
To Add a Drop Shadow to the Coffee Cup

1. Open the Interactive tools flyout, Tool, and click the Interactive drop shadow
2. Click the coffee cup graphic.
3. Drag from the center of the coffee cup graphic to the lower left until the drop shadow is the size you want.

Zooming in can make it easier to set the size of the drop shadow.

This is what the drawing should look like:

![Coffee Cup with Drop Shadow]

Adding the Banner

Now that you have added the coffee cup and drop shadow, you can add the banner to the logo.

Like the coffee cup, the banner already exists as a CorelDRAW (CDR) file. To add the banner to the logo, you will import the banner file.

To Import the Banner

1. Click File menu Import
2. From the Files of type list box, choose CDR - CorelDRAW.
3. Your instructor will give the sample banner.cdr file.
4. Click Import.
5. Position the pointer on a blank area of the drawing page, and click to place the banner graphic.

6. Drag to place the banner graphic below the coffee cup graphic.

7. If the graphic is too large or too small, resize it by dragging one of the selection handles.

This is what the drawing should look like:

![Drawing](image)

**Adding Text to the Logo**

All the graphical elements of the logo are now in place. All that is missing is the text. To make the text follow the curve of the banner, you can use the 3 point curve tool to create a curved path within the banner, and then use the Text tool to add text to the path.

**To Create a Curved Path**

1. Open the Curve flyout, and click the 3 point curve tool

2. Click the end of the small line at the left of the banner, and drag to the end of the small line at the right of the banner.

3. Move the pointer down and to the left. When the previewed line forms the desired curved path across the vertical center of the banner, click to set the line:
To Add Text to the Path

1. Click the Text tool
2. Point to the path you created in the previous procedure. When the pointer changes to the letter A with a curve below it, click the path.
3. From the Font list list box on the property bar, choose Kabel Bk Bt and press Enter. If you don’t have the Kabel Bk Bt font installed, you can install it or choose another sans serif font.
4. From the Font size list box
5. Type The Coffee Shop. The text should follow the curve of the path.
6. Click the Pick tool, and select the path, to make the path invisible. On the property bar, choose 14.
7. On the color palette, right-click the No color swatch
8. Using the glyph (the diamond-shaped handle), drag the text to the vertical center of the banner.

This is what the drawing should look like:

![Logo Image]

Saving your Work

Now that you have finished creating the logo, you can save the file for future use.

To Save the Logo

1. Click File menu Save.
2. From the Save in list box, choose the drive and folder where you want to save the file.
3. In the Filename box, type coffee_logo.cdr.
4. Click Save.